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ABSTRACT

This study is to study the results and analysis of satellite imagery. On normal water
years and drought by using a supervised classification. Techniques using the Maximum
Likelihood. The results show the year of normal water is 1997, 2013. In 1997, maximum
rice field area was 199,943.10 Rai of total area accounting for 48.53%. The area of rice
field was 67,709.26 Rai accounting for 16.43%. The sugarcane area was 12,722.99 Rai
accounting for 3.10 %. The Accuracy.of Overall Accuracy 95% and Kappa were 95.1%. In
2013, maximum rice field area was 215,236.36 Rai of total area accounting for 40.89 %.
The sugarcane area was 49,439.71 Rai accounting for 9.40%. The Accuracy of Overall
Accuracy 98% and Kappa were 98.7 %. In addition less water years is 2015,2016. In 2015,
maximum rice field area was 259,016.86 Rai of total area accounting for 50.75%. The
Accuracy of Overall Accuracy 99 % and Kappa were 99.1%. In 2016, maximum rice field
area was 288,235.06 Rai of total area accounting for 54.76 %. The Accuracy of Overall

Accuracy and 98%. Kappa were 98.6%.



GRERTE

—_
—_
Sb.

HUAZATHB VAT e et iee e,
1.2 QEHIUMATBNATANE L oot
1.3 AHAVATYURINITIREL. .. e e et
1.4 UALUARUBINNTVRE e ik ettt
15 RN, o
WE=anANaN T L B N S AR
1.7 ANHNAFIUIBINITIREL ...t e,

. o) apya) T (a2 i Lo THUU T s A O 0 |

2 W @NAITWASIIUIRETNEITG. ..ot
2.1 RLARAIIMEIN LANASAL. 1211t iar ekt eesibtonee e
= a Adl-dl %

2.2 NOBOHATWUIAATINEATEE. ..ottt

221 NOEJUUIAALATNITANTINITEEING ..o,

2.2.2 UWWIAAALANUINISRIUUNTGANIN . ...

2.2.3 LUIAANLINUNITRMUNUsEnndaya. ...

2.2.4 NanIENUTENUEEINABBINIHATNGITN. .ov e

1%

ao dd o
2 BN L R TN 1o L I

B BN BNNG AR oo
3.1 AT AT T NIl oo e e
3.2 HayAUATNISALSILIWMIDNA. ...

3.3 BDAATIEWIAHR. ..o

o o0 a0 W W N

15
15
17
18
20

21

24
24
25
27



A1 (Fia)

uni WU
B BRMTITIREL ..ottt 42
4.1 AT Ves T A R RS, oo 42

4.2 115N T TR, oo i 44

4.2.1 HANNIALUNTINAANIN FEAU 1,2 WAT 3o, 44

422 MSRUULIAUEATIAN e 47

4.2.3 MSREUAIRIFIR. oo 48

4.2.4 T0YARTIRFBLATINGNFBL. ootttk 51

4.2.5 ARREVISNUTINEAINIIN. oo 59

4.3 1Rl Fenan1s8 uunn s s Tt R AL o 60

5 @TUUWAZRNUSVEHANITANE. ..o 64
30 | TG-S - NS~ G0 | o /A 64

GG TNabe Nsali——” N L. AW .. 67

5.3 TUNMATALRITAL oottt et 69

B B LA ittt srte sttt et eeee et e, 70
LFFTAUNTH. ittt ettt bttt 71
QIANKIN - B B o el i e o e e e 75
TR - e e o e N ST e 43 76
ethnprightce. racarvect. . 81

DVARUAN Bl 83

DIVABRTIN ettt ettt 86

UTEARBTREL ..ot 105



AT

2.1

2.2
2.3
2.4
2.5
4.1
4.2

4.3

4.4

4.5

4.6

AN91TUA1519

TaARUTTLIL Multispectrel Scanner (MSS) 189ANNEN Landsat 5 ...

Ta9pAUTZLL Thematic Mapper (TM) 289A79 e Landsat 5 .......vvvveeee....

SYULTNARAUANTTNEANANINEIN LANASAL 8. oo e,

1
cala

nsanuundayans s Taminau T w2561, i

] = & o v
FIUABWNU TR LT EUMTRILA . o e

k7 1 v 1
A

AnEznN17 19192 e AUNUNANE AINNITAINUANTARUIN v

ﬁl’]ﬁ"\ﬂﬂ’]ﬁ‘ﬁlﬁ‘%@@@ﬂﬁ’)’]ﬂgﬂﬁ@ﬂ (Error Matrix) ‘IJ@\Tﬂ’]'i’%’]LLuﬂL%\‘I’ﬂﬁﬂ’]W bbLIL

[

Aangua (Supervise Classification) fiagan wananayies Landsat 5 Lia

4
6

NNANNAUE U 2540 TOaTARUAUNG T8AU 3.1,

(@]

Ui 1

e

WW?WQﬂW?W?Q@@ﬂUﬁQ’]NQﬂﬁ‘N (Error Matrix) ﬂ@ﬂﬂﬁ?'%’]LLuﬂL%\‘i"gﬂﬂ’?W bbllil

o

fiuguA (Supervise Classification) fayanineiumiaiies Landsat 8 1ia

Do

e

UM 06 NUAAUS T 2556 FRTRARUNUNG 9201 3...0oooio

lﬁl’]?’]\‘iﬂ’]i‘ﬁﬁ"ﬁ'ﬂﬂﬂﬂﬂ%’]ﬂ@lﬂﬁ@ﬂ (Error Matrix) ﬂﬂﬂﬂW?’%WLLuﬂL%ﬂ"gﬁﬂWW (S EM

o

fuRua (Supervise Classification) #pyanananen1aLias Landsat 8 Lia

Do

o

] 1 ¥
UN 27 WNIAN T 2558 ATNRUAMAES TZU 3o

ANIWNITATINABLAIINGNFASN (Error Matrix) 2BINIIINLUNTIANIN LI

ﬁ’]ﬁUQLL@ (Supervise Classification) ?ﬂ]@s;llﬂmwd’mm%ﬁﬂu Landsat 8 1ia
JUN 18 TAunen 112559 daaTMRuNa 38U 3.

[ 2|
a A A e a

ANRALNUNNIT1E s T au Tug09T] 2540,2556,2558:2559 ALAANITAN

[ % o

NEVH ARGV RN D AN e,

11

11
14
18
20

49

51

53

55

57

59



AN

1.1
1.2
2.1
2.2
2.3
2.4
2.5
2.6
3.1
3.2
3.3
3.4
3.5
3.6
3.7
3.8
3.9

3.10

3.11
3.12

ANFUTUMN

[

TT LRI EN N PArT RAATAREDUTAN ..o,
MTBLUIRARANATIREL 1ot eee s s e bie e eeree e
N7uAAItARTIRIANINENANTIANTNEANTIAN .o
sUsmANHzIazAIULTE N UANTIBIANILTALN LANDSAT 4 uaz 5
gusanmuZIazdIuLsznaUANTIBIALNN LANDSAT 8...........
DWENN BN ALFRUIANRINTL oo
NFSUAUNATI LI, L L e e
sfLARLT et TrRINING ATEA. .. itkhueeeeereeeeereereee e At ee e

' = =
NINNEIANINEN Landsat 5 ﬁ?@UﬂQNWUWﬂﬂE"} ........................................

=)
oYY
=
®
=)

NINTNEAIATEH Landsat 8 ATBLIAZHNL

LAsRINE Layer Stack LWaAlANNTI9LI9NLLIKANINE AN

A PR A p
LATANNE Open Raster Layer AR LUUN I AN INANIARIN oo

2 1
o =

NINANNENNIILPINULUAWRY ATRLARNNUAANEY oo,
o & Az 3 . ~
FANUNANENAINTEHANINENATWDEN. e,
o Ao o P
DNANITLNTNINITAAATELAGHNUNANE. ..o

= | p o A
NITNANAN TN ANINENNUNANTI .,

NWANANAEN TUN 18 HUNAN W.A. 2559 NINWAKANLAA

REB&A4B.. o ML Lo I IR b il 9.4,

NIWONLANIAEN TN 18 HUNAN W.A. 2559 NN LN

R o L e i s N B S
A 1 1
ATENNENSIghature Editart ... I e C e AL Y

o dgl dl o T dgj dld
NINNMUANUN AR LINUTFNEN ..

10
13
15
16
17
25
26
27
28
28
29
30
30

31

31

32
32



AN

3.13
3.14
3.15
3.16
3.17

3.18

3.19

3.20

3.21

3.22

3.23

3.24

4.1

4.2

4.3

4.4

ANFUUNN(FD)

o

d” dl 1 v rdla
Nunsradan s ldUss T minew

NNFAAPIVNARIENILLIUNTINAAN TN WLLANTUAMA oo,

HALNRIINITILAITATIRANINLATY FEALI 1 ..

HALNANNNN9IATIATIRANINLATA FTAL 2...

HATLATIZIENqan WL Aeuudasnsld sy leainamn sy 3

BNTNRUNUNR . e

HARLAI ETEIgan NNk Aauulasnns g sy leaminau szau 3

dd‘ o’j %
A A NS e L ANV

ANWILAINI9AD A Lae lEUANNITAINUNAZLTlY Maximum Likelihood

nsAtEnNLANs U 92 laiiNAY Raster Polygon. ..o oo

INBURRISIEr PEIYQON. B 11 ees et g By N

o da/ all dl ¥ rd‘a
N9XUIUNITAIUITLUN NUNN Tl ALl aans ML s lesminmw. ...

Dissolve Flalel M, . =t v, Aot T e

4 ' dl d’j d‘ A rdla
A1ediayarieasunniglidsslamina. ..

d” dl o 1 I rdlq o a o v A
WunFaaeinen T Ml seTaainauanansung I @QVQ@‘W‘]:YQ«}I@TW

ANNNIFAITVRTBLAN VAN oo
HANTIAULAFENAN WIUATTLANATZALT
(D) T WA2550. ..o
NANITAULNIENRANTI LLLANTLRATZALT
b I whiiderighte. racar
NANIAULNIENRANTI LLLANTLRATZALT

(b) T w.A.2556 (c) T W.A.2558 (d) | W.A.2559

1(a) 1 W.A.2540

2 (a) U W.A.2540

3 (a) T W.A.2540

33
34
34
35

36

36

37

39

39

40

40

41

43

44

45

46



AN

4.5

4.6

4.7

4.8

4.9

410

4.11

412

413

ANFUUNN(FD)

wnunHuaasladifuresnislilss Taminau nanisainainunidaganin
(a) T W.A.2540 (b) T .A.2556 (c) T W.A.2558 (d) T W.A.2550..................
HANNTRIUUNLTIGANTN NINENAITEH WHTUN 10 NUANHRUS
1 v
T 2540 BITMRTNING . ..o b et
o a | = dl o dl o &
HANTRILUATNAANIN NINEEANNEN LHaTUR 06 NNAIWUS
T ST N ISRl === N . | R
° = ] = A o o =
HANIIRTLUNENAANIN NINEEAMEN Wadui 27 unsian T 2558
1 dd‘d ogl %
b7 T DV e EutU SUNY S \VUURRR W\ W | [
HANNFANULNIENANIW ATNTEANITEN 1HBTUN 18 Rwiew T 2559

1 dd‘d oa/ v
S RAETNEA S B A e N NI

D

HANTFAIUNITANIWRNIENUINEAINTIN T 2540, oo,

D

HANNIATLUNENAAA NN IZ RN EAINITN T 2556, oo,

D

HANNFANMUNENANTWRNIENUMNHATNTIN T 2558 0o

HANNFANUUNENANTWRNISNUTINHATATIN T 2559.........ooooo

48

52

54

56

58

60

61

62
63



1.1 NuazANNAIAY AR IN

v
= %

ANNBNIUNNIIN Henn121nATaINUNTINNA 1326.21 (M7.0H) N13UNATEIAIU
ieddiu § 12 Aua wazdngiinn 123 Wi n1sdnasasdauninaa SmALIauAT 2 uis aum.
12 us 1atihudanlua) luainansvuiey azinislsznauedwnemnaiduadnvan
v widing dee wazdnalne duwasunyuwiauiull auatiuganiauazinaineaests
dszauinlaesnnlii insmnsen ieawasenisinztgnivalsvisalug i frftieane
@ o P Ly o o = ol i~ J W
Ananaanaztlgning wst falsunantesviteliiiaanenazilgndie faanisamnzign
¥ [ [ 1% & 1) =KX o = a [%
daauacdtnlna izl lu nasmnzdgniies Aetiinszuaunisslumiaudadinnn

Aenginasulasuilasiunnisnisineasluamnansuangn Asudanenglan

faqiitisluniaudgntiannlilunisdisadeyanliisnaszi@anmnaoiuaniniaqiii

waznadasundasndssvdauazrndasuilulszlamlunisinsmefuazanununiidoym
Tunnsdpnimmsnenauazdaninuandan lfet19lilss@nanninaandanindranisainia
(Aerial Photograph) #sannanenadie (Satellite Imagery) axlimatulagising Mifaariu
¥ dl 1% o o o dl = I . [ 1 A QI "
fayaialAandaiudnyoyussasinanisandy Remote Sensing A19T3THNIEWES “Remote

. " =K o Y aa 49/ % 1 Yo « o
Sensing” w188 N1sfUianszazlng Tnadfianuarununailinanalisn “dunisdisma
pevagauAmaNtRala Anu Inenldlainnsdudatudanantiu’  AdiuAidn Remote

) 2 = aa = i <, o
Sensing ANAMNMNNENRENFENed Wil n1sd1aanszeasing

v

= dl a o o Qd‘d ] A
ANNLNEN Landsat LuTaaesarunandisaaninenngsssuaianaugeinaslan e

L)

[ %

nflupnafaudisaaninannandAnylunisdisaninainsassngnd iduanaaui
Usznavlunanedepdu fayaannssuLnaIaT9enan (MSS) 1 N1 ATBLIARNALT 185 X

185 m199nlaiums H9naaziaen daya 80 X 80 tums szuuivdayaanszuunilen iy

WL N8 azRaaAndnszUy MSS AaszLy Thematic Mapper (TM) Iaeidl 7 Ga9pau



FNUATIAAUAITANA 30 LUAT X 30 AT AN3NeN Landsat gafdselamillunng

U

v
o o

o A o‘d‘a v al ¥y d‘ v o o d‘
Anuunnisldlselomnaulin viedslideyanlndnesiudaqiiuninign

u q

) o’l v 1 1 o v 1 1 1
HanTenULUILAdeNamaInEnIngsn Aauielulszmalnadawluninansznuse
nasinwasneen Tnenduduudemfinainaiaduise duuds ludasgaiu ludeauneu
o e K A a A” 1 1 A a =) A a
NUANAUS D9 LABINEIEY WazIAA Hluiivtes Tudasimaulnuien 09 iaunsngian §
nansznulnensaiunsinEasLaziuas B liianauaautii lunismnzilgnivg dssimelne
= £ ] o v R = |
Wudsyimandszanaudsenauananinensnssaiudaulng duussasdinaids sanis

ﬂﬁ‘:ﬁﬂ@ll'ﬂ’]%‘WVﬂ\‘]ﬂ’]?Lﬂi&fﬁlﬁ‘@ﬁi’]ﬂﬂ’]ﬂ

n17ldAraaiadnmasyas lnavizananAusia NN WAN9LAeN Landsat 5 -8 1unng

2 1
o o A =

AranuninERsnIsui AnNdAtysanste lun1sRnn uAsIRdau T lua AN N AT N

o o a

Jeudpimailan sufanisulasuilasmasnasnizilgnivaadnelslugdasdindindnd szt

q

a4 dayaaannindign1aienniIunszuaun1gAse i lullsunInasaun A A ans
% | L Ay P R % } 8 o
LA uazeunnInaaeuiluacnen Ndeyaninmene gnsieuazuaiutl Ussneuiunisas

d’j dl [~3 v a o v e A dl o d” all
Wuniudeyaniaguinase auimniiin s Tamivizaununnisdlrananiaauinlunui

= =~ ° 9 = A =
Lﬂ‘]:f[ﬁl?m‘ﬁ‘wﬁ\i’m%zuﬂ‘)’luﬂ’]ﬂ@ﬁ‘]_l’]ﬂsluﬂ’]‘im’]m FIZALLUBDIIALAZIL TN

v ¥ 1
o o

=S a o asf A c A 3 d’ v o‘d‘a
n1sANHIARE AT IR IRnUszasAlne Anwnasilaeunl aenisldd sy leminauaes

Nunineasnssd lutndndtnlng wasdniuiuas nasdsegniflddayanisdisascasing

1
A o

= i~ 3 cala A A
AMNNINANINEN Landsat 8 memLLNuwmﬂmﬂizImuwmuu@umumﬂquwmwsimmm

& A
WUNLNHFTNTT

1.2 A ANNLUBINITAN Y

A = o Ao ' A & A ° a
1) LWﬁﬂﬂﬂ‘]ﬂ'qﬂQ@ﬂV]NN@m@ﬂ(]?Lﬂ@ﬂuLLﬂ@Qmﬂ\‘lwuVIﬂq?LﬂHmﬁiu@’]Lﬂ@W?VﬁJW?’]N

FndpnElan

2) wallrsunauaangnsiasitiainnszuaunissiumauds Tnanisduwundeys

AognATIANIIAUUNLEIRANIW (Supervised classification) Tuiuinginsms



1.3 ANNRIATIADINUIAE

duilseTamisaguaunsuimuinaunaciinasdes lunisliugediegyaninaiw

a

o g A o 9 =
ONAANUYBANNUNITINTAT L‘W’ﬂu’]&l@iﬂi‘ﬁiuﬂq?qf]ﬂLLNuﬂ']?LWWZﬂ@]ﬂWﬂVﬂQﬂ’]?LﬂH@? LN S

(%

A o‘d‘a dl,l d‘ A
N Ml srleminaulununvisegumy
1.4 AAULAAADINUIAEY

1. AAUYAAUNBNANE

v
o

snunensuaisnn aanisUnasesiuiiennn 132621 (As.nx) ste
132,621 (@nA§ Winfu 828,881.25 15 nnsunasasdaufiesiiu & 12 frua tHun Aiuans
UszA1 ANUAWHBY AILIATADY FIUAUNAIIIN ANUATILENYTEN FIUAUBNADY ANUANTEN
ANLAYINEI FUANIUNNIIN ANUATIIN AUAATHING LaTALRAgNITIEN fvaftinsiomaa

u

123 uiie nastinAseddauninaa BmALIauAT 2 Wik aup. 12 uis Huanisfnsiendsiae i

a =~

NALUY Ansiany a1tnaadssalan (Sndnglavia) uazewnands (3audn

NARZIURAN AAFANU 2 Na3aluge

a ¥

nAle Ansaniy g1neeIfinnlan LazaNeLeIEin

Wepzaunn  Asseriu aunendlneand uazeneradnlss (Saudnglave)



SUNBNIUNTW Javrinieailan

A sowdiiin |:| Gmadifod
rarmncan [ ] Smemanifon

it [: frsiuendos
|:| Gmuamedszin [j -
FIp— :] drumedios
l:] Amususiies E Aruaviafag
[ ST e WJ
: f/ 9.U1952M
0-32L.4 4 16Kllometys

- o
a.lpaivmailan

NN 1.1 WRUNAUNANTUNNSIN AINTANEHTAN

anwouznwnyszmadoulnniluannewsnuiisadun unsuinvionde Jusi

nulvadudundirananan ansoiznisldlsslamiaudiulug) luainansvuisy i

& A a & i P~ ¥
WUNLNBFITNTTH @ﬂqWQNﬂqﬂqﬁiﬁﬂﬂqllﬂmﬂqwuwLﬂuLLUUN?’QN U3 q@]ﬂ’]@ IﬂLLﬂ

9aAUUIL

1 v
a o

BNALAILAUNNNITUTTIN AR UNG N1 AN

Qe

{
a '

BHAILA LA UNQUNIUINADUNAS ADUA AN AN

BUAAADUNGAANEUTUARUNAINABUNNATNUE



2. VALLAAATULRAWILAZLIAN

1 v
A o

fayaninnen1aneN Landsat 5-8 Tudaalnitlng uazdaetiiiuis Ae
P = = & A ° = v o
TILABUNNINAN-HUIAN TIN.A.2540,2556,2558,2559 NUNAN®H INBNTUNTATIN 4915R
Aeoglan azgninniudanindisuaznszuoun1siiAzilunnsfne Al Tnauddeya

st

o o

AYANARATUTIAINNINTNE AN Landsat 5 417 10 NunTRus Tw.A. 2540

=2

1)
2)

a o o !

AYANAAATANNINTNEAILNLN Landsat 8 JuT 06 NUNUE Tw.A. 2556,

(=

ar

JUN 27 NNAN TIN.A. 2558 LAY TuN 18 NuaAN TIw.A. 2559

e S)o

= L

1.5 AaANAILLIDIA

YD (%
a o o !

= o Novy = P
ﬂq?ﬂﬂﬂqﬂ?ﬁuiﬁmﬂmﬂﬂi@mﬂmm@qﬂﬂ']waqﬂﬂq’]LV]EH\I Landsat 5 a8 NUNANTI

U

ANNBNIUNATIN Saudaieulan aqlluanani3uls https:/fearthexplorer.usgs.gov/ N

q

n13susNdaganInnfena en TuTIn. A. 2540,W./.2556, W.A.2558,W.A.2559 L1ie1i1N19

a

uwlaninuazdirsnzinadeyanis s loaiinan
1.6 DL NANARNE

Landsat 8

\uTianetnnIandn39aNTNeNITIINTIR AN Landsat 8 THYNASIUEI9
Taagiiadui 11 nuaiug 2556 Aaenalulagnluindrganiameuniiuuiinliaauns

< 4

dudeyannlfinintuluisaziuuazialosuiniu a1ainan Landsat 8 NWsaNiLandTas
paulunaN1sonIad L manaznuinlnddelinan tasanasdftifinisdisalansiae
14 4 o P = A
Landsat lfiaqusunisnsaasuamunwdayanwaznisasuansanaienilauilanenen
o)\ S\ S . [SIEY 4
WOEAAN 2556 naganiuiazdena iy U.S.Geological Survey wianilaguge iy

Landsat 8 atingtilunianissalyl


https://earthexplorer.usgs.gov/%20%20เพื่อ

n1sd159aszazlng

o 2 dl o [ % A [ dsj dl A %4 Y
Lﬂumimm%mg@mmm ANNTDANTUSNUN Tmﬂmzuummzwaumﬂmsgmjm
dl o = o = o o v ] dl a dla %
ARUNNENANTUNIENANTURATINAULATU LT Tmmm&mzmmmnmeuu‘wmmﬂ@m

I | = d‘ MYy oo o o o ! 1 ng//
(Sensor) YTANINRNLANILNL N Imﬂﬂuimumnmmqmm AT
NTIUUNLTIANN

nisauundayanuulinndugua (Unsupervised Classification) flunnsanuun
v 1 dl v a [ dJ (% Y aos o o
fayaannisumiannasaesaan i indipasiugsiideldinee luntsegluuy wesin

o

slﬁﬂ’]ﬁ‘LL‘]_i\‘iLLHﬂ?WﬂﬂZLﬁﬂﬂLﬂuﬂ@;Nj (Clusten)azAuaLLIAIAIINAI NTBININ

nasaquundayauuniiugia  (Supervised Classification) tun19auun
al dIQJ v o/ o U 1 dl -] v A 1 v o/ 1 dl
PeazuaNfiaInaiauaniRrasinnInduediels et ldaenngudeyadoatinedm
: . 4 \y \, ] ) -
duapnNgdrasan i umunueseazieen lunsauundeys Inaanninidy
o ' o ng/’ = ] | o i o j il A
AALNUIBINAN FAINUUULTENIN NANAIBENN(Training Fields, Training Areas 1178 Spectral

Signatures) (572 ARATINSNaNS, 2557)

1.7 ANYAFIY

1) N124519TULALUN LATRNITAT N ARaSTaU Tz 1WYTaN s LUt Nl

921N 9UNUIZNALBTNNEATINTIN HN1FULENUNNIINTNEATHINTUNIN 1B AR

a

4 o ol ) B o P G < |
2) mawlasnutlasnisldlseslominfurasnunnislgndes INuNALNINTUNGT

wunnignzilgnunding Tutl w.e.2558,1./.2559



1.8 NTALLUIAA

aLﬂiﬁxﬁLLaszﬂ’QNWWﬁﬁﬂQ’]ﬂﬂ']')Lﬁﬂ&llﬁ?ﬂ

TdsunsuasaunAgimans

NISATUIUUIANLRAS
ngdasunlasnun
LNEASNTTN

2ANRNTIATRYANARUINNUNANE

Y

N1FANLUNNUN NITALUNLTS
NISLNEEAS ¢
BUUANL
E e AgUNaaNE RS
AFIAFALAINYN
o v

N1SANBUNABNA B a9UR9nS

FNUUNLTIIANIN

\4

wuunuaasnsilagunilasnisldilss e

Sa P
NAUUADNINUNNITINEAT

andseuazagilna |

AN 1.2 NTAULUIAAIUIRE




uUNN 2

LANFITHAZINUIFANLNLIUDY

NISNLINITLUUIAR NOHJUATNITNLNIUITINNITH LanasTiNedeaiLannddy e
a s =2 dll a ] o
LﬂuLLuQ‘Vﬂ\‘ﬂuﬂ’]ﬁ‘ﬂ{]Uﬁ]LLﬂZﬁﬂ’]ﬁ‘ﬁﬂ‘H’] (309N719AARINAFIARDLNTNINIFINERT TUBILNE

1 2 v

a o o A aaa o a aa o % v 1 a
wannnNSndanwolan IndtadUnfuasdniiunias aandeyan ndienaines Landsat
5-8 FaeNARANITILAIIETINAANIN uuLAALURLA East AN Auadn Tnaditiand

a i o 1 491
PR HGET Iz R ST R T
2.1 fayan9ien Landsat

2.1.1 dauani1nnsN Landsat 5

U

2.1.2 fiayapaned Landsat 8
= a dl dl ¥

2.2 NEuAHIAATINeITes
2.2.1 vy uuAnLarnngdisaaszazing
2.2.2 LUIRANEIUINNIANUBNTNANIN

a dl o o 4
2.2.3 uuaRAneAUnMIaIunlszinndaya
= 09/ 1% '
2.2.4 NaNIENUTIHUAFIDINEAINTIH
e,
2.3 ¢udAeAneatag
2.1 TAYANINANEAILTAEN Landsat

a

ANILREN Landsat LuTareganIaaNd saninenssssufngnians
ﬁy ! o v KX Y d” a A a
Augnalaas uazvnnistiuiindeyanuiiolanu1iney 3 Adsse AnaNAeLINTadlAINIg
gnasugacnIANesun 23 nangian 1972 ugzraNinaWieNgniEenda Landsat utl 1975
TAsannemnaien Landsat LANLTun89TATIN19131190190190UW WAZRINIALUSTNE
((National Aeronautic and Administration: NASA) 1&8n1sTaunanisanaean Landsat 19

Fosat @atilutsdnuesnienauy  Aszuufivdeyanarsafinuacivaiatoinau

(Multispectral Scanner 3198 MSS)



METEOSAT, (USA)
(ESA) NOAA 7;‘: w
o orbiting ! \
0 LONGITUDE satellites
< 35,900 km.

INSAT
{IN['I']IJ\]

J~1E

LANDSAT

T - G - el GOES-W
GMS seostationary satellites (USA)
(JAPAN) 135" w

140 E

MW 2.1 Mudndlaasrasniangdisiansnenslan

ﬁu’l : http://conf.agi.nu.ac.th

k24

Aanusaztszinnareg luuuaduaudgas g9aanianiszanns 36,000

' '
¥ Aa A o

Alawns azansugalunimmyusassiales inligllaniandiaesatiui anomaunguil

a

dqulunjaziiunnanananu AN LarA19 L NaNgAteNINgNIEALNIA LTUAILNEN

9

METEOSAT @qazaasfnagjiviiagninn wusiu fanan 2.1

2.2.1 fiayanaiien Landsat 5
ANLEN Landsat 5 gnasiugaelaaslatasam McDonald Douglas Delta
3920 9INFIUANEINIA Vandenberg, California 1adlil 1 Hunan w.A.2527 Jaquiudslnas

wariiuindeya AndnHzAIEN HEURIARENANS 1.8 1wmg BN 2,000 Alaniu

[

v
AITNAITB9N05AAs 705 Dlawng anwuznislaasduiusiuaenindlasntudalan Bas

vinyuiuunulan 98.2 a9 Jnandfiesdulunisiuiindeya. - 9:30 w. 1381 1 saulunis

v
) a

Taaswiniy 99 w1 tuindeyadimfunn 16 Ju szuntiuindeya MSS (Multispectral

q

b

Scanner), k8 TM (Thermatic Mapper) R318az@8an N 80 AT (MSS)Las 30 AT (TM)
o a -~ o ~ A o ]
AINNANTRININ 185 NTalNATLAZHB18N1991191uNAIANIS 5T anHurgilsieuas

faqﬁﬂixﬂﬂur}mjmmmmﬁﬂu Landsat 5 AININ 2.2



FICGH CAIN ANTEREA

GLOBAL POSITIONIMNG,
SVETEM ANTERNA

AMTENMA MAET

ATTITLDE

MULTEPECTRAL SCANKER
CONTRAL MODULE

(1) OIMT ANTERHA

FROPLLSHN
MODULE

X-BEAND ANTENNA
POWER S-BAND
MODULE ANTEMNA

WIDEBAND MODULE

THEMATIC
MAFFER.
MUL TIVISSION
i ESTRUMENT
SPACECRAFT MODULE

nw 2.2 sUseansziazd@IulssnaunanuaIAIL e LANDSAT 4 uag 5

(Barrett and Curtis, 1995)

o | & = , d'
MQ@%UH\H’]UH AR LATANNANANRRANUTINIANL

(Multispectral Scanner: MSS) Wa® FUUNTWHUNLAN1ZAA  (Thematic Mapper: TM)

dl A a dla
PATANHALRNISNAIN A A

=

uanaNUiIiszuuNstnenendays, LATasedasis Lavauiuddnyoy undUsc&nEnw

49 IINTUNFUNASIULANRTRE (Solar Array) Eeassnnannszua i 160e 2 Aladms

10



11

A19749 2.1 meﬁfam%uszuu Multispectrel Scanner (MSS) 2RIANLNEN Landsat 5

5¥UU MULTISPECTREL SCANNER (MSS) FIURTLALANTIN 80 LNAT

Aanuznanay (lulasiuns) ﬂfizmw%’agaﬁ‘lﬁ
WUUA 4:0.5-0.6 (ﬁ”ﬂﬁu@m) WEINIT AT ANTNANN LI
LUBA 5: 0.6 - 0.7 (bA) WEINTRANT
WUKA 6 : 0.7 - 0.8 (aunssnlng) MENTTUAT IR
WLUF 7 0.8 - 0.11 Bunlsusalnd) | e, Annadulufy, wauasive

nan: drnnunaumalulagiaamAlacgNasauLNA

AMNATN 2.1 LATBINAIANANEITIIAAY (Multispectral Scanner: MSS) AN

AZIDEAIBININ 379 Instantaneous Field of View (IFOV) Ag 80 x 80 LA WATAINNL 13

ATBLIAQNTLY 185 x 185 ANTINALALNAS

A5 2.2 meﬂfmﬂﬁuewu Thematic Mapper (TM) 224A19L7NEN Landsat 5

5zUU THEMATIC MAPPER (TM) FIEURLLRYANIN 30 LNAS

ANNa1Aau (bulasiums)

LUBA 1:0.45 - 0.52 (HI1N1)

WUUA 2 : 0.52 - 0.60 (12819)

LUUA 3 : 0.60 - 0.69 (1LA)
WUA 4 0.77 - 0.90 (Bunssalng)

WLUA 5 1.55 = 1.75 (BunsnisnAandiy)
LUUA 6 10.40 - 12.50 (AUNIILIAAIN
ER)

WULA 7 2.08 — 2.35 (BUNTUIAAZTIDN)

dssinndayanls
AIIAAAUANFHULTINTNEIEN, LENNTLAZAINN
=
eI

a =
WEINTTIANE
1 A = A
ANHUANANSTAINNTAANAUARD TSWAR LU
WITCURN"

1 09/ 1 dl 1 1 OgJ
ANTNLANAISTRI LI LAz Aoun Tu g1,
1310 NIATANIN
A dy a a
N, P NTUIUAY, LA TN

v a v dgj a al
ANNNEAUNAUNTN, ANNTURU, ANTNLATEA
=
YagNe

LEINTTAIAL

N3 drunnunauinaluladaimAuazplasauina



12

AINANIN 2.2 921U Thematic Mapper (TM) Usznaudsefoaianum 7 wuwa

|
1 A

TN UIULLUANINNILATHANNNF19T09T9AAY (Band width) wALNI152UL MSS &

= £ a dld dl o QI 1 % = 1
TNHUATLREANTIN 30 LNURAT GL'Vii‘zﬂ‘]_lLﬁ“ll’]ﬂmm‘l’lﬁﬂqqsﬁ\‘l"ﬂzﬂqLL‘LlﬂZNL‘l’]ﬂ“’liﬁ@uﬂﬂﬂﬂqqﬁ‘g'ﬂu

MSS

2.2.2 fiayan1amey Landsat 8

Landsat 8 anatfa a9 lusangalniasanis Landsat Data Continuity

|
a

Mission (LDCM) lidsfiayaningausnssuslignilaesaugesiaag daufluninidiafias
iULTR S Operational Land Imager (OLI) and the Thermal Infrared Sensor (TIRS) ANLNEIN

Landsat 8 BNU1ANT917 30 nnunIAN 2556 Neliinnstsnnsdanisaes USGS Taasgs

2 1
A A

wilafulan 705 Alawms Areazi@aanin 15 wag Wuszuuieldd1miu n1sfudnyoyno

o & 14 a v a

CApnUdeNs, NARdaNan1IREN LATA uNNLTe9R L TuAINTUN19U NIRRT ANA

U U

v
o

a [ 54 = 1 = a A & a '
NARNNTUNTBDHNANVIUNEHN Landsat 8 aginiilussuuuasilss@nsnin neanmnme nnanan

=~ i v a v p a A
LV]ﬂIuI@?J [ﬂ@‘]_mu‘ﬂ\im@ﬂ’]?sLMU?ﬂq?LL@Zﬂﬁ‘zﬂﬂ15]5]]@3;]]@ﬂ'mL‘V]ﬂllsluﬂ’]?mﬂmWNﬂW?Lﬂ@ﬂuLLﬂ@Q

F ]
A A a [

FeiunlfegeidssAnsnan AnmauzgilsauazedAlsneusineaesnaiien Landsat 8

AININ 2.3



M 2.3 sUsanszuazduLlsEnauuanTaInNLiaN LANDSAT 8

(Irons and Taylor,2018)

13



14

AN979 2.3 WARNTTULTINARUNITANINTNANILALN Landsat 8

LANDSAT - 8 OPERATIONAL LAND IMAGER (OLI) waz THERMAL INFRARED
SENSOR (TIRS)

LLLI‘LIé mmm‘m?iu (VLNTﬂ‘iLNﬂ‘é') ‘J’lﬂﬂgl,aﬂﬂﬂ'}‘w
Resolution(tN65)
1 0.43 - 0.45 (Coastal Aerosol) 30
2 0.45-0.51 (Blue) 30
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5 0.85 - 0.88 (Near Intreared NIR) 30
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2.2.4 NanIzNUTTNUANEINAGIDINHATNITH
o 1% ] 1= 1 o 1% dl
AuudslutlszwealnadanlugJuansznusaniainemnsnssn Inedudauddn
a ! 1% ] a ca” ] = [
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v
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FIRTUNU

A9 2.5 Fasihauniszauilgunauas
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2.3 UIINLN LU
WATUAT MM (2559) THANHIN9aLUNETRgaeIn N NEA1TEN THEOS
= = a o a a o a o dl” dl
ANEINITBELNELMATANIIATLUNITEIRANIWLALINATANIIANLUNLTET AN IDIN WA
v 1 = = &R o U o o a 1 ﬂl
nsinsasaIndayanindiaaiaannalan nsiAne anansie Aaniamaslnd e

MinnnsAnANIanai N zanlunaa uLnd ey a N UAN1SNHRIFEATNNIRLWNLES

[ %

= 4 dl % o v % a o a
mo waziFauimeuaNgniesniiainnszusun1sduunfayafaeinAtiAnIsauUNEs
ANINEAZNITALLALE dAgluuiinasin R n1sarsunEIdnglnanisdne

1 a o‘d‘ dil ai aal o % a aal 1
AN RSN zan luAuN1TnEas Inedgnisauunde yamaqanin 2 35 uuuls
NAUQUARAZILILANAUAWA WLIINNIRMUN TR AL AN ATINGNABILBINITRLUNEGS N9
AzuunBUUNIALgual AN AN NAaYsINTatay 62.22 A9uAN kappalyinil 0.56 LHa1in

nsatfraumauiunisausnuuuldnaiugua idianugnsiassasbasas 20.00 kappa

1 o

WAL 0.11M31zNsRuunLLUAAUguaiina s Muaieyasfag AAnN1Teeann1AaWIN

| ]
= [ a 1

WaAIu N AatArasdnglunfssunn R AN NFeeNgandn uuliindugua 14
AnwilszAnsnan 2e99an1sauundssinmnis s lominau

A7IM308 gnsuMLazAny (2557)laAnnasulraumeunaanslunisauundaya

a

N9l sz laainAutaz8enAguAL $21399N 19 UUNIAYALITIRANIWLAZNITANLUN

fayaninidadng NunAnmn awnelnslaa Aamdanigyautfs Inedeyanindianiainasing

q

TnaflusaatielunisAneunadawssasnisauunusazilsziny dlunnsaiuundeyaids
qan W lEREN1sALUNLLUAITLALA (Supervised Classification) Iaglfpnatifnautnay

\ugengn (Meximum Likelihood Classification) lunagAnuanmnat@asnialasuuilas

a k4

nslidseTaminau dwfunisanuundeyan wideinglfimetianisasnednglaanszuaunis

a

WENE9UNIN (Image Segmentation) BIAZNANTAIAINNNFAINLARINITIRADSHN i 1&un

=

NIA9IE9, A, 31379, NITNIZNANUATAINEYEL NANIEANHINLI TENIFIUUN

a

4 o [

fayanimdeing WinadnsAiaougnéiealaasan (Overall Accuracy) 44N97138N193 1N

q

v a aal [ ¥ a o Yo % A ]
TRHALTINFANIN Iﬁﬂ’lﬁﬂ’]?"’mLLuﬂ‘LI‘ﬂE;IjZ\]ﬂ’]WL‘NQIFIQSLVW’Y]WQWNiq]ﬂ[ﬂ’ﬂ\ﬁ@il?’)ll AR 91.88 411

aal o v a o % . . . ¥ %
NI UNUDYALTIFANTWLLUNINULA LA (Supervised Classification) Iumﬂﬂqmqﬂmm

a

Tnaganiien 72,15 Wawsauinaunadnirestszinndayanislddsslaminauuas feiln
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ARNAWIT 6 Uszinm lHun iesuazfelgna®ne, unasin, Aundild, des, Sudidzugs,
ANNI9T HAANEIBNIR BN fayannTeing iAiaaugnsiasaestssinndayaninnan

v
[

AINIRIWUNTRANINULLAALALA (Supervised Classification) 114 6 azian iwe1zd
Fannsauundeyadeqaninuuunniugua (Supervised Classification) Hnistziluiuaes

oy anInndnaanisauundayanIWEmg

9

waatlnau 1evya (2558) ladnsanislaanulasnisldlselominauainnig
d” dl o a o o A v 1 =
pe18WUNlgnenawign Tuanetiamsenis Aamdan saylan Mnwdiaaaian Landsat

TunsAnedaiuinisilasuulainisdgnanani Iagldmaiianasauuniunidqanin

2 1
oA

supervised classification wudnfiuntlgneaaanasnluginasifnsznis Saudaisnian

Y 1 !
=l cala

FaLGIT] W.A 2545-2558 HWRUANITUQNENNITININTY BTl W 2545 Anns s laminau
Tunstlgnenennaiiisan 12.89 me.nu Uw.a 2550 An9lEnmueLgna19wisina
I 72.92 m3.na T w.a 2555 A0l ARulunismslgnanawis inaugn 156.21 n.nu
wazludl w.p 2558 Wunlunisignanewasinauasinesiaiiiasny 259.91 A9.ny AIN"9
a oy ! = @ Y 1 o a = dy .
Basnzifiayaluusarthiivlédninwminsly srneransznis 8n1saenaiunlgnananns,
QI da’ =) 1 o Y a = dl 1% o
Wawnn ) O wanzantladefinuasegna nstgnansnnsiduermmnemnsnssui tdnaninle

U ¥ 1 = dl = ua/, =l =3 o % o
AaudinaeasnINeITNNEAINIEY | LASANLINEIATIREL A liTaneasns Tugne
fmANIiUNN sz natIanlgneNeWng)

ARG AM3QATRII(2560) IHANEINNTILAIITITNIsanUaeafingFaunszanlunun

Ugndey tnaldmatianisa1uuni@edng (Object-based classification) aMndiayaninae

= K o o o o dl a '
ANINEN Landsat : NTRANSN @WLﬂ@VL‘VIN’]J\I FINIANWNLWGT Iiva LTz ilunislantanas

ANgiFaunszan 9usNNINAREN TN UNANEN TIN.A. 2540,2549,2556 Lazil 2559 LA

1 &
a o = o 1

o dg, [~ 2 a o dl % 1 &y -dl 1 a
NATNINITAINUNNUABHANNANTAAUIN RN 6 WMVIMQﬂﬂqﬁiﬂLLﬂ Wu‘l’lﬂ’]ﬁ?ﬁ‘ﬂeﬁ’]ﬁl,

k7 1 2 v k7
A = A

fufidnaan, iuiau j,ﬁuﬁ?ﬂlﬂﬂ,ﬁuﬁmﬂmiﬂﬁmLL@%ﬁ”uﬁLfl’ﬂ\‘]LL@Z?@I\‘]ﬂ@jﬂ@%N AU
Javlanszuounisaieingreunissauun fnuuadmisfimediilu wpandau /gl
ANBHL/ANINZNEN AMNTINNTA1WLNEeTRE (Objectbased classification)Analdl
AnuuaAIleesls lfnanisAnuae wmfﬂmiﬁ”uﬁmﬂfﬁﬂi:‘lﬁmﬁﬁﬁumﬂw’1xﬂqﬂ

7
1o

8ot TuTn.A.2559 ANuNgagawiniy 171,200.27 13 uazTln.A.2540 HRUAINEATNITHIAL
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NUNUS9TNTIRQIEALYINAY 124,773.12 uaz 30,902.1 13 AINATAL WATHANIIANHINIS
= o - - A i o ~ .
wasuwdasingansuaulaaanlas Aunnemsnssndn.A.2540 U w.A.2559 Annslantans
Anggagaiiniy -0.44 (nseniu (Tg) Wundeauaziisssugnfnnisiniiuiig
pduaulneanlangeqalulln.A.2540 FUN.A.2559 Wil 0.47 nseniu (Tg) waz 0.26 W

7eNTN (TQ)
ANTA 999N9ALATARLZ(2554) LEMIn1sAn NIl A und aenis M s Teminmu
o o d' R ! =y, &
wazifadeus gl UL 92AT NIUANET: AgNUYTINUATUNNNAN HOIRBNINTS WY
aeNszUNe agnsigszansdlnedszarauais tnaldmatanisaunnidiqanan
foarii 2 Tame nagauunuunliinfugua (Unsupervised Classification) waz N13a7uun

Oy & 7 e h 2 vy ' = a Y
LWHUUNINUALR (Supervised Classification) ‘Léﬁmmg@mwmﬂmqmﬂwmmu@m@a AR

|
cala

SPOT-4, THEOS uaz ALOS lunisAnwinisldyszlaarinauluaien sousudayanin
Anaen Ul 2008,2009 waz 2010 ingaquundeys wianisldlsgleminauuardaln
panTaueany 7 dszian Ae 419/13, w139, aaut1ddn, ldman asieds tunyanssns
uaz mafting uanasAneAe 1 2008 D9 2010 wuga Annsulasuutlasarniuininanstnl
Tnenaniztiudnlunan waswiilunundgnitawaeials iusauiunan wazwudanig
wasuulasnislfdssleminavlunundgniouasiels Anaiutaden1afuiAsegnanay
faan uussdunaeusianasasuulaesnislidselaminu Tnaenizifadufinuaiuauau
1 o A 1% o A = 2 o [% a 1
slaniairau, e lfresaiiBounening anunaiieaasdinodiuiunisilneg v wilas
= < o Ao o o gy A o A Y oa <
neasngsaiianawity ufadandrAnyinlinundgninauasiialsminninau Ao
= 12 ° o a oAy = ¥ = ¥
waiaszasdinadiniunistilnesell fninwmensiane liaannisdsenavenanties 1
A o ey = & A ey & o Y °
anpnazyinliinemsnanenaiunazyngnvunt W lHidununinsasnssuieasnamanils

Visanasanisldananalimnsalianga



uni 3

8L UUNUIAE

e luafaiidunisdnen nsRARINATIAERLNTNINTINERT TUaLNaNTI

v Aa

a o = dld o” = -=l‘ o’l 2 v ! a
NNAinnelan Jnatiuanuazdninuge AMNUBHANTNDTE AN N Landsat 5-8 1agl

3

T inAllA@eaqan WL LN LG LA (Supervised Classification) Taaiyaifiuliiinig
wasuulasnisldsslaminfuliiianugniieiazinimena afnsnisdasuulasinug

NWNNITNTAT

3.1 Araalen g lun12fAneE
3.2 fayauaznaiiususandoys

3.3 303LATITHIYA

3.1 inspeianldlunisAnmn
3.1.1 gulnsnlipbespafanef
aju ASUS K556, CPU Intel Core i7-6500U,up to 3.1 GHz wariniIfnan
NVIDIA Geforce GT 940 7£11in139179714 Windows 10 Pro, 64-bit
3.1.2 Tsunsuililunisise
3.1.2.1 TdsunsnssuuansaumAnNAans
3.1.2.2 lsunsudszananadipanziiiaznisanuuniieys

3.1.2.3 TdsunsumsaaauALMLNAINT A Google Earth

313 wsasieuanauuuefATauuiuialan (Global Positioning System: GPS)
TnglAFuANeuLATIZiAIN @1 RANERT NIANTNEINITITNTNAUAE

AIUINRDN ADUZINHFTANAATNTNENNTEITNTFLASAILIARDN NUNINENALIULTAT



25

3.1.4 1 9uRAN G lun1suanH AN

(34 Brunton COM-PRO Pocket Transit ) Tmﬂiﬁi“ummmélmq:ﬁmﬂ A7
LANANT NNANTNYINTEITNTIALASRILIARAN ADLINERTANGATNINYINTEITNT IR LA

A
AAUIARAN NWINENAEIIAIT

3.2 dayawazmainusIusandaya

3.2.1 #ayanInanaiiax Landsat
3.2.1.1 AN Landsat 5

lidayanintnaniaiay Landsat 5 sztuiiuiindays Thematic Mapper (TM)
aazlen NI 30 AT IUSTLLNANET9ARY ANNNA19TR9NN 185 Alalums THun 3 429
AAULAIAINDIITY (R:G:B) TIAAURLAINAINENIAAY 0.60 - 0.69 ALLIINAINNLNIAAL
al Oy a = dl o =K dl o dl o &
0.52 - 0.60 AUIRUANNEIIARY 0.45 -0.52 TulAsiums TANNANHATUN 10 NUATWUE
W.A.2540 NINTNYANINYNLTDUNUNANEY BNoNIUNNIIN Aauiafiznylan innnannaid

T1anann U.S. Geological Survey (USGS)

2 '
] a9

AN 3.1 MWanam g Landsat 5 ﬂiﬂﬂﬂquwuﬂﬁﬂﬂ’]
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3.2.1.2 Aad Landsat 8

= v

Mdauan1nanan1aa s Landsat 8 svuutiuiindaya Thematic Mapper (TM)

u u

$18ALBEANIN 30 AT TUTTULNANETIARY LA 3 TNAAULAIANNDLIAY (R:G:B) 199

|
- | =

AAUALANNAINNLNIAAU 0.64 - 0.67 ATLINAIMNELNIAAY 0.53 - 0.59 AUNRUTAINNLND
dl o K dl o dl [ '8 o ai

AAY 0.45 - 0.51 lulAgiums UuANAIWIEHBdUN 06 NUNIWUE W.A.2556,5u7 27 Wn31Ax
o A = ! = a P °

W.A. 2558 LAY TN 18 NUNAN W.A. 2559 AMNEIEAIANLNLFNUNUA AN®I BILAANTUH

W SandaiElanyionismadiuanann U.S. Geological Survey (USGS)

7 '
] e

MW 3.2 Mwangm g Landsat 8 ATAUAYNNUNANEN
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3.2.2 fiayaaand199an1AAUIN
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o o % = A A tdl Qi 1
WAZANALATNNITANANILRIEUAIAINNINANINEN Google Earth Tufieafiuin nldanungmn

k2 1
A A

dindeluniaivdeyald Tnavianasguifiueniia iunnianisinenslugnensunngs 12

ANUA ANUAAY 10 90 TIFILULNTBSANNARELLATINI9IAN Ao ATaIHaT LY AT LML AN

[ %

APULANURaTaN (GPS)

3.3 ABATITUTaYS
3.3.1 squsandayanandnaniaien Landsat 5 -8 landesdnazianisiiasie

a

foya  Tnuniwazgniiunnlugaedl 2540 uay 2556 Aedasiitnnd 4991 2558 uaz 2559

'
1l

A 1 = 09/ v 1 = = A = dl v a
ABTINTIALAY 2511979 1AAW HNFIAN- FU1AN LaanA Ina e uNUaan s azliluNAq
umivunMesgifiaya INaANNFaNIINaNIILATIZA
3.3.2 Mnassansuusnndaaaanen eeldllsunsuszuyansaumaniaans
al = :/j & =l al :/j & al
AN Landsat 5 A lRauue 7 wius LazAI9Lnesl Landsat 8 azlianum 11 uwuufazs
n7rLnuNNTaasalii
3.3.2.1 ilalilsunsuiiaasiinis N usnInagaaia s 1aanldlAsasiaann

Raster > Spectral > Layer Stack > 191 nJ) Layer Selection and Stacking > ABNULUR

ANNENTIAZYIINIG Input File > Add > iwanviiudiasa Output File > Click Ok

| "] =] s Untitled:1 - ERDAS IMAGINE 2014 B Layer Selection and Stacking _ O X
Home  Manage Dats | Raste vectar  Ter, Google Exrth

Input File: [%ima) Clutput File: [*img)
& &

Layer: Al w~

>

Data Type:

nnnnnn

Clear

Input: Mone Output  Ungzigned 8 bit ~
DOutput Options:
@® Union () Intersection [ lgnore Zero in Stats

III jach A0

Cancel Wigw Help

NN 3.3 LATR9NE Layer Stack tWaALEAN1SILSINULUANITNAE AL EIN



mﬂﬁuﬂfmf]ilﬂméﬁ@g@ Open Raster Layer > i

o <

ANy Output File > Fit Layer To Window

Select Layer To Add:

File Raster Options ~ Multiple

| Look inc| (23 landsat 8 strack

|® lst_8_stk.img |
o

File narne: .|St_3_stk.img

[

REERDD D

Files of type: | IMAGINE Image (“.ima)
truecolor : 15441 Rows x 15121 Columns » 9 Band(s)

Ok

Cancel

Help

Goto ...

NN 3.4 LATRYAA Open Raster Layer iNaatdun15LLanIwmL g

AN L FANAIIN L NN TN LLUALASA TS a8ILAN

NN 3.5 ﬂ"lWﬂ']’JLﬁﬂNﬁ‘i’JU‘i’JNLLUUﬁLLﬁQ ATRUARYN

k4 1
al e

NWUNANEN
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k2 ! U !
I ]

o o = K 1 a ¥ a8 A
3.3.3 n1ssaiNunAnE1Ia nAnanea1nan liaseupquinunane Tneld
Nsunsuszunansaumanaaniinain i1 mmsini s aauulasnis 1l sy taminsiu
o o = s A quv o & A
wavvinntsulaninsaedangni annisutlanndnanina e lidnlanundneuaznis
o =3 ¥ 1
dmafivdieyaniraunlunszusunissald
WaldsunsussuuansaunagdAans nan1sinidindeya Raster N
~ P o v o o . g
ANUNENATOLAGNNUNFANEI NNINITIFLTINULIUALAT WaTHE1 Shape File 12LIRNLN
= A 3 A A
Ane a1ntiulaen ldiAsasile Arc Toolbox > Data Management Tools > Raster > Raster
Processing > t31ngusinsing Clip > 1den Input Raster iludiaganindiannoiiasnseungy

7

WUNANE > 1aan Output Raster 11 Shape File > Click Ok

ER=]
g Cl =]
5 laximum
1903396.721327
& L |
I H *Migm X Maximum
— 7 600777.951189 | | €41599.78%83
g ¥ Mrimum
il & Joins. = 5
1866636.651217
& B LAS Dataset o
|Elmmxrmm«om Geometry foptonal) |
Output Raster Dataset
C:Wsers\asus Documents rcGlS Defoult2 gob\c03.59_Cip =
NoData Value {optional)
65536
=Tompeste Bands
i, Create Ontho Corrected Raster Dat I oK I Cancel | |Envircnments... | | << Hide Help

o J o ¥ 1 L
NN 3.6 mmwuwﬂnmmnmagamwmﬂmqmam

v i
=] o

azlinmanaiasnasaLAgNNUNANEY AN 3.7 nszuaunissialiindinnindae

a

= dl 3 ar dgj dld di o a g A o‘d‘
ANNENNNINITAAN WA ANET NaNnIn1gudaninuaziiasizsinanis s laauinaue e
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NN 3.7 MNANENNYINNITARATALARNNUNANEN

Walilsunsuilszananaiinsyiiaziinisanuundaya wdindiays Raster nawang
ANWNLNTNINNTHANUNANE Laen LEAsaeila Multispectral > 1880 R:G:B 5-4-3 azlfiilu
Anania aunsen (WINWTT0L) - Color Infrared (Vegetation) sl.ﬁamumﬁmmummg’m et

> : = o Sy, o e P Ao v : =
nasuazavfiaua U@ asiludinty AunetaidevisenunlasazasfiauAnilugan

AININ 3.8

Untitledt1 - ERDAS IMAGINE 2014

NN 3.8 NSHANFNINANLANINLNNUNANE
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AN 3.9 ANANEATIEN AUT 18 TuNAN WA, 2559 NMNRKANIRA R:G:B 5-4-3

Q = = a v ] a a A A
ANDIEANNENANANATS JAALAIAINNTINATIRINGTINTR (Natural Color) Ad W

wrsnuazviaupiugiaes audinaesdauedfunisasfiauaastianTg

NN 3.10 MWAEAALTAEN YuR 18 AUTAN W.A. 2559 NMWANENIFS R:G:B 4-3-2
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3.3.3 Aipnziuazianisutaninaieaiaiian Inanssuaunisaiwunieyaiuy

o

AnfuRua (Supervise Classification) ANLEWNNIANMUANUNFIBEN (Training Area) iy
AN

nezuaungmalld laenlfimsesiia Raster > Supervised > Signature Editor

dl o A o A dl
PANRAZNINITINAUTENTUUANUN

o

eREEN

i Signature Editor (No File - 0O X
File Edit View Evaluate Feature Classify Help

BD &3 TME VA

Class # > Signature Name Color | Red | Gieen | Blue | Vaue!Oider| *

i

I 3.11 LA3RLEa Signature Editor

a

; o = 3 dl” A o ! I ol
Drawing > Polygon > Nn1321ausan uanunsnainengldes laminmu
o u o oo B A ey oA o« _ o & Ao
> UWANTBHANNINITNINLA WwanliiAsasile Create New Signature > NMUUANUNAIUWIU

az 10 ARNA

Qass# > SigrahweNane Coow Red | Gieen  Bhe Vabe Oider
i I » Ciass 1 Bl o5 0% 0M 1 1|

*f«

AN 3.12 MSAUUANUNABENI L UNUNANE
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k7 1
A A

IHANINITNNNUANUNF2E19ATL 10 AATE NTzUaun1TFalilsaute 10

k4 2
o I~ o

Aaa i 1 Wunsaetne TnelfiAsesiie Merge Selected Signature > azl# 1 Aunsaaging

La9MN1T Delete 149 10 AANEA8N

¢ A " L AT

o Signature Editor (No File)

Sige Muge&lmeasﬁgmm}lm Green | Bie |Vaiue Ordes| #
01 4

5§ 6
0154 o
0177 8 8
0120 3 3
0191 % 0 W

Merge Selected Signatures
a

i Signature Editor (No File) < 7 - (m] X

File Edit View Evaluate Feature Classify Help

= 0O +b & =L Z\'\_ V_A

Class # 1>; Signature Name | Color | Red | Green 1 Blue ‘Valuel OtderJ &
Class 4 B o052 0299 0347 4 4
Class 5 Ml o012 0313 0370 25 5
Class 6 B 0183 0323 0387 6 6
Class 7 M 0154 0301 0354 7 7
Class 8 B o077 0313 03N 8 8
Class 8 BN o020 0% 03@ 3 3
0191 0330 0360 010
11 b diufisnuasnsss = 0.187 0.3_25 0.368 11 11 v
< >

& Ao ' 1% aa
AN 3.13 Wuﬂm'Jﬂﬂq\iﬂqi‘elﬁﬂﬁ'xtﬂﬁﬁﬂﬂu
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1
cala

’Q’]LLUﬂWHVIM’JﬂEIWQﬂW?SLTﬂ?uIEIT Uunm Uﬁ FRIN1IATULAY N3 IzNlaNe

v
o

finya > Classtify > Supervised > Output File FsTaudaaannanfivdeya > Click Ok

B Signature Editor (sig3.sig) - O X K Supenised Clsiicton *
(uipd e gl [ 0ulput Distence Fie
File Edit View Evaluate Feature Classify Help WEI B
B 0O + ; H \/\ Unsupervised... . | AbueOgiors. | o=
Class # |» Signature Name |- - |- | |-m lVa1ue Order | ™| | O3fuaay Chsscaion 2 % Best Classes Pes Pl
10 10w [ 0507 0B63 0533 1B 6 Deciion Ries
2 4203 Bay I 0.0 0307 0365 17 2 i ]
3 W01 uswhdrass B 033 0407 0445 18 48 | >“°‘°‘“‘""°"*= Noe
4 A100w13n [ 0567 0544 0564 19 B4 velep Fde Posemeiic ke -
5 4301 Widudm ey B o2n 0327 023 20 @ :
6 U200 nydiw [ 072 074 061 A % Ml il .
miii || - =——
v
£ > [ Classiy zeros [[Use Probabiities
Classification Using Signatures Bach | ADl. || Cencel || Hep |

NN 3.14 NFIASIZARAAILNTEUIUNNTTIRANTIN LULAINLAUS

LHa7N193LATITNAITNAANIW LUuifURLAgI3e AINALEIRMUATuRY

TuszAUn 1 fauuANUNFARet19 (Training Area) 4 naNA28ENT LA WUAINHATNITN, NN

2/ 1
el a

WNHFATNTINT wu‘wm wummuuavmﬂaﬂmw @’]LLuﬂﬁl"lﬂﬂlﬂN@ﬂ’]ﬂTﬂi‘uIﬂT Unnu e

WAANANTIRANIN AININ 3.15

NN 3.15 Nmﬁav‘hmﬁmfmxﬁ@mﬂmwm?q sEAL 1
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1 v
a

TUgLAUN 2 AUUANLN

o

Fa8tig (Training Area) 5 ngusaatng Lawn W

a
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wnaati 5 0 1349 12 5 0 1371
U519 27 10 7 3910 1 0 3955
1t ununas 13 77 8 3 804 0 905
naj1inu 4 1 10 10 2 20 47
COLUMN 1011 5490 1406 3999 839 20 12765
TOTAL
OVERALL 0.95 %

ACCURANCY
KAPPA 95.1 %
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M1514 4.3 mswmsmma@umwgnﬁm (Error Matrix) 2429n19971LWNLTS

AANINW Lmuﬁﬁﬁ'uQLLa (Supervised Classification)

\Wadui 06 nuAwWuS T 2556 49
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alndv1dn

k24

WAHANTINA

A szAL 3
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MSAMUN A WY wuas  wise lEw wtu ROW
daya i AUNAN TOTAL

aas 7183 119 95 1 1 0 7399
LTl 0 17266 6 0 0 0 17272
WWASYN 3 55 4578 0 0 0 4636
W59 8 8 0 5596 0 0 5612
e ununan 4 147 4 0 383 0 538
najinu 7 19 0 0 3 80 109
COLUMN 7205 17614 4683 5597 387 80 35566
TOTAL
OVERALL 0.98 %
ACCURANCY
KAPPA 98.7 %
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1514 4.4 mswn'\smsfmﬂfaumwgnﬁm (Error Matrix) 2429n19974WNLES

AANTN LL‘LI‘Llﬁ']ﬁ"LI;:]LL'a (Supervised Classification) %’ﬂa&an'\wd'\ﬂmmﬁﬂu Landsat 8

' [
e Bl

LNAIUN 27 NNS1AN 1 2558 Ha9LiNNULAY sEAU 3

MFAMUN WY 2R Wuas w1 lNEW witw ROW

daya U1 519 AUNAN TOTAL
VLT D) 2192 25 2 31 1 0 2251
Aas 2 4897 1 0 0 0 4900
unagti 0 > 179 0 0 0 1792
U159 2 0 0 8163 1 0 8165
1t uAunas 2 101 2 0 1632 0 1737
nyinu 12 39 1 0 16 84 152
COLUMN 2210 5064 1796 8194 1649 84 18997
TOTAL
OVERALL 0.99 %
ACCURANCY
KAPPA 99.1 %

AINAN9N 4.4 LARSNANIIATIAAaLIAMNGNFBsTaen1slziuiuaasnisduunlull
w.A. 2558 TneliiA1Aanugnéieslnasqan (Overall Accuracy*100) winfiuasas 99 Hen
Kappa winfid 99.1 % Tuiuiinemnsnssd a1wun biile wndnalinisdsiluaesiuiuaain

D o g & Ay ~ g W fK* =4 ) & A
,uq?qﬂ,iﬂﬂumuﬂl@ﬂ NLUNBDE NN1TULUTADINUNLARIWINLALALIR LL@zslu@Quﬂﬂﬂwu‘V]LN@\i

uaz@algna3s Annsuziunesiuiinemngsy fnw 4.8
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1514 4.5 mswn'\smsfmﬂfaumwgnﬁm (Error Matrix) 2424N1997WUNLTS

AANTN LL‘LI‘Llﬁ']ﬁ"LI;:]LL'a (Supervised Classification) ﬁﬂa&an'\wd'\ﬂm%ﬁﬂu Landsat 8
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LNAUN 18 AunAN 1l 2559 d29lnNuNLae seau 3

MSRMUN U BeE WAAY W1 WNEW  uyiu ROW

STRHE W 519 AUNEN TOTAL
VLT D) 1261 1 0 60 1 0 1323
aat 0 4397 7 2 18 0 4424
WAL 0 0 1543 0 0 0 1543
W59 0 1 1 11461 0 0 11463
igupunan | 2 107 9 2 1254 0 1374
ny U 0 32 0 29 11 78 150
COLUMN 1263 4538 1560 11554 1284 78 20277
TOTAL
OVERALL 0.98 %

ACCURANCY
KAPPA 98.6 %

ANENTN 4.5 LARINANIFATIAAUAINYNEHBIT89N191 st uiuaeanisauun lul]
w.A. 2559 TagliiA1Aanugniiaalaasan (Overall Accuracy*100) winfiuasas 98 Ha0

Kappa Winfiu 98.6 % luiuininemsnssy anuwwnbaidu wrdnalnistsduneanuinunsng, 18
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425 ANRALUDINWNLNBATNTITH

TANNUNTZUARNNTALATIZTNINEN AN NeN TutaeTl 2540,2556,2558,2559 W&
P1uMNNnAeasn I flasullasni sl la M AunuAN1ean s ®Rs AnL (%) 10
1 Adl da/ d‘ 1 1
ANLRALADIWNUNGIR ("La?)

A1514 4.6 ALaAgNuNnsldlseladunaw Tutdqgil 2540,2556,2558,2559

AUNANTUNNTIN AAWIRNELAN

Uszianil 1l 2540 1l 2556 1l 2558 1 2559
(Wui9) (Wui9) (W9 Huid)
A101 1 67,709.26  215,236.36 26,406.13 36,622.18
A203 o8 12,722.99  49,439.71 84,987.23 61,418.93
WA101 uvaaiin 81,880.44 551335 18,428.60 5,683.89
A100 #1319 199,943.10  132,429.74 259,016.96 288,235.06
A301 Ifitludiuman | 41,411.98  32,754.46 70,205.67 82,410.45
U201 watu 8,261.95 41,455.14 51,403.52 52,074.49
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Tutlw.d. 2540 da9TRTUUNENRTETUAU 920 TN AN UNUIE19RIGALNNAY

U 9

2 v
=
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ubanas 9.40 Iaalfirnasugnéiaslagsis Overall Accuracy Winiu%atias 98 {A1 Kappa

Wil 98.7 % uaglutdnetiinuda Aa Tw.a. 2558,2559 1A, 2558 HNuNuN51949gaWAL

1T v
=

259,016.86 3 aasiunviann Anlludenas 50.75 Nundesviaiy 84,987.23 15 Aniluias
az 16.65 funudinawiniu 26,406.13 15 AailuFaaas 5.18 Tnaliidiaaugnsiasiassan

Overall Accuracy infiu5esas 99 NA1 Kappa 11fiL 99.1 % Uw.A. 2559 HAUNW1519

[ )
A o

49AAWINTL 288,235.06 13 1asiunyiavun Aalluiatay 54.76 Nudaawviniu 61,418.93
13 Aadluieaay 11.67 Auiurdaawiniy 36,622.18 19 Asilusasay 6.96 InaldiA1Aau
gnéieslna3In Overall Accuracy WinfiuSasas 98 HAN Kappa Winfil 98.6% T4aannRad
nau waas Twan Wasya (2558) lHAnmnslasuuilasnislilsslaminauannnisaene
d” dl [ a o o a v I al
Wunlgnanania luawneanamsynis Aandaisnglan taeldnwanamiameas Landsat T
= o % = = g pr o A o a
nsAneEINunnIatuLlasn1stgnenewi s aeldmediatneaiunenisldmaiianig
fﬁﬁLLumum%mmmw (supervised classification) Faag19lun17ANHIUNAANTUBINT
o 1 dl [ v a yvaa o o o
uunusiazileziny a9lunagaasundeyatdsaanin 1IN WUARLLANA LU
(Supervised Classification) Taalfa1afifinauinaziiuganiga (Maximum Likelihood
Classification) lun1zanua e easnisasuwlainis s TaasinAuine 1 LGN aaw s
AENTIU UAZAIAARBINL AIINTNE 4VBUUT LazAL(2557) THANEIN T RaLNEUNAANS
TunsduundeyanislddssTuminauuacdsUnaguan seudnansdnuundeyaidiqnnan
Al o T o ey % ; 4 o )
wunanm annalnslaa Asudnniyaus Inedaganmarasameninelgmidusaaengl
nM9ANEININaANTIaINIANKUN LA azlszIAn v lunnsauundayaiiege nwldianag
AMMUNUUUANTUALA (Supervised Classification) TaaldAafifnanninaziilugangn

(Maximum Likelihood Classification)



69

oymuazailassa

1. do9ma12e9n7stiunna At nenlinseiy Aedeyaniaiian Landsat 5
o K o dl o & ¥ = 1 dl
TN lWIUN 10 NUNNRLE 2540 uazdiayaniaian Landsat 8 lussuunae Ay
o = o o o & v o o o o = =
dunnawluduin 06 nuAIWUE 2556 fUdUR 27 Ang1AN 2559 wazdun 18 HuIAN 2559 39

o R A Y o e | o a e oA A A
?iﬁﬂgLQﬂqIUﬂqﬁuumﬂwquﬂumqiu @ﬂﬂmzwucl’]ﬂ’]?slmﬂﬁ\giﬂmuw@uLLWﬂﬁm\‘]ﬂu AR WUN

N o ! Qi 1 o o L % d’l dl N o I [ %
LALAUTAILAAZAIN WULAALANANSAL mﬁlummmusluwwmeﬂuumm\mﬂﬂmm

2. luntsaviuniiudeyanirauin neanudeeggauialiidiaaneinauinuazi
Auandlunsivdeyadnma aalununanmivatasaus Ml ssazinauiulunis

< v
S ENIRENA]



70

ARLAUDLUL

A 1 a dl A 1 o A ¥ 1
1. Argiaannndnaanenilasauaite ldiwaniunils arunsadenliddos

2
A

iAauTet luga9gAnUIL INaZENNINENEAIINENTLIIAZTININIFIUBNNAITINUN Hinwas]

el

Tunn azmliidse@nsninlunisdnuundanugniiesanasiisadtanaainnaey

2
< v

2. lunsasiuniudeyaninauian Arsiudieyaninauinlinsaunguinunne

a

k2 1
1

11nnan nananaslilaaldnanafmlunisguiuiisaagag (Random) wanzlunsanuunsias
21AENTNINBANUNFIBENS(Training Area) INBINNATAIINGNHABdLDIN1TRLUNTaYA UaT

1 fayalunnIngaasetA1AINNABITIBINITANRLNT2YA

v 1
=

3. lunsduunieyavideniuuaiiunsioetie Asld google earth Wnauglifiae e
% ° Y e o AP 0 3 =
AINGNABNTaINITALUNT By INg1Z9n Heun lunnsdisadayaniprauIneaiiagnN

1 A ° v K A ¥ K d” a o 1%
E‘!ﬂﬂﬁﬂﬂﬁ‘ﬂﬂ’]uqﬂluﬂ’]ﬁ‘mﬁﬂ\‘l Aun9n google earth ’Lum?mmwuwuuim LAZATNITN

= 1 % = al) v
RaNTdNTU 1hau T 16



AVANS UNIINYNAUULTATS
Copyright by Naresuan University

All rights reserved



72

UTTUIUNTH

naNgARuNINGI. (2560). Atwas [aaulail]. AuAWEe 20 waAanIaw 2561, Windelaann

https://www.tmd.go.th

2 [
< d

NM9RUNTRYANIN. (2553). NISAINUANUNEN IR warRuTnegauTLansBelsziAn
aa9ReanGaanis [oawla] duduile 11 woAan18u2561 1dntelaann
http://natres.psu.ac.th/Department/EarthScience/remotel/chapter9.pdf

AUANLTRT99ANENA39anTNeNsan. (2553). 29tAR5ARIAITENEIFIANTNENG
Tan [eeulatl]. Aufwile 11 wopAMe2561,

Winneldann http:/conf.agi.nu.ac.th/agmis/download/publication/454_file.pdf

AnTE 599009 LazAniy.(2554) naaulasunilasnisldlsslaadnnu uwaziladauss
dutARauUINlsznns nsdlAnE: naunaTinuAzUNNIAM LaIRaNINTS
WANUAIINTEUN As19usFUseT Bl lnadszanauann. @uﬁﬁmﬁlmﬁm
NANARNILNERT, ATUS INEATANART, NN aedeslud, @ealus.

NINENNTFTINTNAUAZAILINE RN, (2556). Aratfiauaudan 8 [aeulasl]. Aufudle 20
WO AANE 2561, WAtalAaan https:/geographymsu.blogspot.com

WATUNT WENaY. (2559). nasaaaINNIstlaauwlaInisldlssTagunavwazdein

[

ARNAULALNATANSILATITUNIWKLLLEITRY - NTAUANET LUATN =

qQ

o %3 U

WUEARITEe9n9. Aneniinug an.u., uundnaauuseas, Asolan.
waaelwau agya. (2558). n1sidaguwilainisldlszlaaunauainnisaenafud
ganenenisn Tudnegiansenis Aandianealan. anegdnug on.u.,

NMINENREWIATS, Nernylan.

k4

ANEH AURT. (2543). ANFWUFIUAIUN15A15995z8£lna Remote sensing. N1ATT1

u

niAERs AzdianAans, sunanenaudealud, weslud.


https://www.tmd.go.th/
http://natres.psu.ac.th/Department/EarthScience/remote1/chapter9.pdf
http://conf.agi.nu.ac.th/agmis/download/publication/454_file.pdf

73

o e

ARST SMaAN5RIL. (2560). NNsANEILAZALAsSIzINsUanUAaa R gisaunszan luNuN

q

1 4

Ugndas InemAlANITITUUNTITAQAINTRYANINANEANILAEN Landsat :
NSAANEIAILNAINGINN RINIARTLWILNTS. INLTNUS 9.1, HW1ansanae
uLgAa3, Wnylan.

ANTTR BejLilag. (2545). msﬂs:qnm‘ixuummumﬁgﬁﬁmm%umiagadﬁm@

dl = dl O’J 1 1 Oﬂl 1 Q
szazlnaianisdsziiunnmaasanniinanlugauunddnnisdssgs
ATINITNITUHUNUAEDNAITAULNAUNITAR. JW1aINIUNNITNA e,
NINNHIIUAT. Ut GIS-84.

a s = [ 14 L4 o

A73N3I8 ANTUUN UazAE.(2559).nstdFauinaunisatuuntayanis iy sslae il

NAULAEAIUNARN AUSTEWINNIENISAUUNTAYALTIAANINUAIBNITIILUN
dayan1sidednglagldnindradsuninandnainaiaiianinalan.
INUIFNARTUULTUTIN NN, NNNANEIAEWLIFNT, Widnylan.
a1914neN e & uduienagu. (2560). A19LviaN Landsat [aanlail] Auduiiie 15
a v K ¥ .
NAAINIYY 2561, dintieldann http://kanchanapisek.or.th

7

dntinaunemsdandaiisnglan. (2553). TayaNUFIVAIUNISINHATIINIANHLAN
[eaulad]. AuAuie 11 noAan1ew2561, W ngldann
http://www.phitsanulok.doae.go.th

AninauimumatulatiaoniAwaz)iansauma. (2561). ANasian Landsat [aaulaii].
aA % dl a ¥ K 1% .
AUAND 11 W ARNNE 2561, 709LAA0N https:/Awww.gistda,or.th

F9¥ AIAATLNNA. (2550). NIFATIAFALAMNYNADIUDITAYAAINNITIIUUNATNAT
VAR, NNARTIRAINTTNTIEET AMLSAAANITNANERS, N Anedenaluladnsraay
INEIFULE. NNNNUIBAS

Remote sensing. (2556). n1sd1sqaszasling [aaulail]. AuAwie 11 woAan e 2561,
¥ K %
dinfal&ann https://knowledgeofrs.weebly.com

Nasa Landsat science. (2556). Landsat 8 [aa1lail]. AUAuLHS 22 WO AINEY 2561, WD

1Hann https://landsat.gsfc.nasa.gov


http://kanchanapisek.or.th/
http://www.phitsanulok.doae.go.th/
https://www.gistda.or.th/
https://landsat.gsfc.nasa.gov/

74

Barrett E.C. and L.F. Curtis. (1995). Introduction to Environmental Remote Sensing (Third
Edition), Champman & Hall. London. 145 pp.

JARS. (1993). Remote Sensing Note Murai S. (ed.), Japan Association on Remote
Sensing,

Lin,Y., Zhiyan, B. , Haibo, Z. , Yuntao, Z..and Xi, L. (2017). Habitat monitoring to evaluate
crop disease and pest distributions based on multi-source satellite remote sensing
imagery. School of Information Engineering and Art and Design, Zhejiang

University of Water Resources and Electric Power, China. 66- 78



AVANS UNIINYNAUULTATS
Copyright by Naresuan University

All rights reserved



MANUIN N TBYANIANITRITIANIAFUIN

76

an X Y AnunuzAu
1 627849 1895578 Wding
2 628020 1895606 Wnding
3 627751 1895629 Wding
4 627720 1896073 Wnding
5 627493 1896388 Wding
6 627856 1896740 fae
7 627858 1896568 AMUNA9Y
8 628024 1896556 fae
9 628235 1896819 dalne
10 628279 1896841 d3ziin
11 628284 1896985 49
12 628737 1896736 g3z
13 628711 1897438 fae
14 629147 1897459 fae
15 629653 1896191 fae
16 629415 1895936 17
17 624913 1892280 w1110
18 625070 1892510 Wding
19 625208 1891714 w1110
20 625284 1893808 fae
21 625778 1894025 11417
22 624700 1893637 Wding
23 624470 1892664 fnalne
24 623557 1893015 W10
25 622331 1890667 Wding
26 622650 1891157 W10
27 621969 1892021 Wding




an X Y AnunuzAud
28 622322 1892001 Wding
29 627722 1896517 14w
30 652959 1892448 Wnding
31 625941 1892657 Ul
32 625582 1892453 Wnding
33 622268 1893660 fae
34 627126 1893862 w1110
35 625205 1894030 11417
36 625041 1894279 W1ding
37 625451 1894903 11417
38 619876 1892537 ATUNAN
39 619714 1892541 Tl
40 620454 1892500 AUz
41 620579 1892502 d3ziin
42 619711 1891845 11417
43 617940 1891691 Wding
44 628846 1883146 QYA
45 622220 1885217 Wding
46 622233 1884464 w1110
47 623279 1883846 fael
48 622653 1884306 W1ding
49 621447 1884405 11417
50 620862 1883706 Wding
51 621646 1884196 147
52 620692 1887514 W1ding
53 620464 1889793 Wding
54 620514 1891392 daziin
55 629118 1896171 fae

7



o X Y Fnenizing
56 627971 1895318 F1aALTn
57 627562 1895289 Wnding
58 627778 1898363 fae
59 628154 1898346 fae
60 628309 1898317 fae
61 627203 1899107 fae
62 628007 1899525 17
63 627443 1900267 Wding
64 627351 1900044 Wding
65 626554 1899961 fael
66 618855 1897125 Ul
67 611881 1901441 W1dng
68 617816 1878397 LTl
69 623313 1878993 117
70 625308 1879551 W1
71 624804 1880977 W1ding
72 624602 1881402 AUNAE
73 624515 1881536 W1ding
74 624369 1883126 Wnding
75 625763 1884062 diEiusiuna
76 624675 1885477 fae
77 624114 1886178 11417
78 624093 1886297 d3ziin
79 624099 1886978 11417
80 625258 1888373 avunNang
81 626174 1890808 TRUTb!
82 625476 1892672 W10
83 625474 1892300 d3ziin

78



an X Y AnunuzAud
84 617238 1895432 fnalne
85 617007 1895241 LIV
86 613503 1892965 Wnding
87 612813 1892196 TRUTb!
88 615182 1889435 Wnding
89 615875 1883428 TRUTb!
90 616321 1885452 w1110
91 624164 1880209 TRUTb!
92 621229 1879342 W1ding
93 623132 1879979 Ul
94 627210 1894054 W1ding
95 626143 1893924 Tl
96 626321 1893688 d3ziin
97 627725 1893581 daziin
98 627411 1893116 1147
99 627657 1892818 Wding
100 628534 1892719 w1110
101 629087 1897670 fae
102 629378 1897478 fael
103 629478 1896099 g3z
104 629200 1895646 W1ding
105 629605 1895573 W14
106 629426 1894568 W1ding
107 626583 1894649 W10
108 625214 1894608 Wding
109 625562 1893208 W10
110 625564 1892497 Tt iiely
111 625109 1892015 Wding
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an X Y AnunuzAud
112 625456 1891655 Wding
113 623986 1894895 Wnding
114 623901 1892743 W1ding
115 620990 1892872 Wding
116 627812 1899180 Wnding
117 626469 1899157 Wding
118 626530 1899533 17
119 624224 1899123 Wding
120 627204 1900746 Wdinn
121 627220 1901997 11417
122 629892 1887557 W
123 629978 1886744 w1110
124 629434 1885886 LTl
125 629021 1885583 TRLTb!
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MARUIN A NISAATIZMTIRANTN

HANNSILATIZMLEIRANTWIIN. A.2540

83

dszianmsldlsslaadfine Audlls  Audinanead  Sawas
A101 W1 67,709.26 10,833.48 16.43
A203 2asl 12,722.99 2,035.67 3.10
W101 ungasin 81,880.44  13,100.87 19.89
A100 ©1514 199,943.10  31,990.89 48.53
A301 g ununas 41,411.98 6,625.91 10.05
U201 Byt 8,261.95 1,321.91 2.00
394 411,929.72  65,908.73 100.00
HAN1SIATIZREIAANINTIW.A.2556
dszianmslddsslaadfinn - Audls  Audinanmni  Sewas
A101 W1 215,236.36  34,437.81 40.89
A203 Bas 49,439.71 7,910.35 9.40
W101 ungasin 55,133.5 8,821.36 10.47
A100 11519 132,429.74  21,188.75 25.15
A301 g ununas 32,754.46 5,240.71 6.22
U201 najiiny 41,455.14 6,632.82 7.87
394 526,448.91 84,231.8 100.00
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HANNSLATIZILEIRANITWIIN. A.2558
dszinnmsldszleaufinn Auils  Auinanens  Sesar
A101 w1 26,406.13 4,224.98 5.18
A203 2as 84,987.23 13,597.95 16.65
W101 Wiaguin 18,428.60 2,948.57 3.61
A100 ©1514 259,016.96  41,442.71 50.75
A301 laiEiunuNas 70,205.67 11,232.90 13.58
U201 ngtinu 51,403.52 8,224.56 10.08
394 510,448.11  81,671.67 100.00
HANISALATIZITIAANIWLIN. A.2559
Uszinmslds=laausinn  Auills  Auinaneans  Sasa
A101 w1 36,622.18 5,859.54 6.96
A203 aag 61,418.93 9,827.02 11.67
W101 ungasin 5,683.89 909.42 1,08
A100 U519 288,235.06  46,117.60 54.76
A301 g uAunax 82,410.45 13,185.67 15.65
U201 ugtinu 52,074.49 8,331.91 10.10
394 526,445 84,231.16 100.00
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Monitoring of agricultural areas in Phromphiram District, Phitsanulok Province on normal

water years and less water years using satellite imagery Landsat 5 and 8
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a 1 dndl 0” a 1 S 0” % A a o a o o
AnaMed dovlntdnd uazaeslviuas InalimatianisduuniEeqgnnin uuuiniugua
(Supervised Classification) AL AUNTNIMUANWARIBEN (Training Area) WU apnInive

ANUITUANN AR el MEaNN13ANTNAZLITIE Maximum Likelihood

o

HANNIANHINUIIIBNITITLUNTRANIN WLULNNTURWA (Supervised Classification)

u
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F |
a =

Tudaetindunng 16un dw.a. 2540,2556 Tw.A. 2540 ANUNWF1949gALINTL 199,943.10

Re

14 sasNunanN s Aslutanay 48.53 NuNUENWINAL 67,709.26 13 Anlilusasay 16.43

1%

Wundaswindu 12,722.99 13 Anilutanar 3.10 TaaliiAaAanugnéias Overall Accuracy

Wiafugenay 958 A1 Kappa 19117 95.1. % Tuln.A. 2556 A unu1fiiagegaiviniu

2 [
%

215,236.36 1 B09NUNYIUNA Andlugasay 40.89 Wunaasvindy 49,439.71 13 Anilubas)

az 9.40 TaaliiAnAaINgNFias Overall Accuracy WinmiSatiaz 98 HAn Kappa Winfiu 98.7 %

v k2 1
o 1%

wazlutgastlinuas 16un dw.a. 2558,2559 Tw.A. 2558 HNUAUIG19498AWINTL 259,016.86

v !
13 aasiunianne Aaduieaas 50.75 TneliirnAaiugnéias Overall Accuracy Winfu%as

A 99 HAN Kappa Wiy 99.1 % Tw.A. 2559 HNUAUIS94IqAmniL 288,235.06 13 299
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7 [
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Wunvianne AnluFenay 54.76 Ineliirnaanugnsias Overall Accuracy WinruSeasay 98 H

AN Kappa Winfid 98.6 %

o Q [ 3 4 o a = dd‘ o’l a =
ANEIA vZTYW@Wuuﬂﬂ@H@JYW@WuuﬂﬂﬁﬁﬂﬂWW,ﬂﬂWﬂWQWﬁﬂlLandsm;ﬂﬂuﬁﬂﬂmu@ﬁﬂ

09/ b %
UILLAN
Abstract

This study is to study the results and analysis of satellite imagery. On normal water
years and drought by using a supervised classification. Techniques using the Maximum
Likelihood. The results show the year of normal water is 1997, 2013. In 1997, maximum
rice field area was 199,943.10 Rai of total area accounting for 48.53%. The area of rice
field was 67,709.26 Rai accounting for 16.43%. The sugarcane area was 12,722.99 Rai
accounting for 3.10 %. The Accuracy of Overall Accuracy 95% and Kappa were 95.1%. In
2013, maximum rice field area was 215,236.36 Rai of total area accounting for 40.89 %.
The sugarcane area was 49,439.71 Rai accounting for 9.40%. The Accuracy of Overall
Accuracy 98% and Kappa were 98.7 %. In addition less water years is 2015,2016. In 2015,
maximum rice field area was 259,016.86 Rai of total area accounting for 50.75%. The
Accuracy of Overall Accuracy 99 % and Kappa were 99.1%. In 2016, maximum rice field
area was 288,235.06 Rai of total area accounting for 54.76 %. The Accuracy of Overall

Accuracy and 98%. Kappa were 98.6%.

Keywords : Classification, Supervised Classification, Satellite Landsat , normal water years

and less water years
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